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Lesson 1: Introduction to Morae!

This lesson describes the key components of Morae and shows 

you how they all come together when running a usability test.!
!
“The beginning is the most important part of the work.” — Plato (427 BC - 347 BC)!!
Although people talk about Morae as if it’s a single computer application, in fact Morae comprises three 
entirely separate elements. Morae is a suite of applications, just like Microsoft Office. And just as you 
would use Excel, not Word, to crunch numbers, the three components of Morae have their own special-
isms.!!
Table 1 reviews the three components of Morae and explains why you use each one.!

Table 1: The components of Morae and what you use them for."

!
What about “Morae Player”? 
If you explore your Morae folder (C:\Program Files\TechSmith\Morae), you’ll also find an application 
called “Morae Player”. Some people expect to be able to use Morae Player to playback Morae recordings. 
This won’t work. You can only playback Morae recordings (.rdg files) in Morae Manager. !!
To continue the Microsoft Office analogy, “Morae Player” is like “PowerPoint Viewer”: it’s an application 
that you will never need to use, but you may need to give it to a colleague who wants to view the Morae 
highlights videos you have created. Morae Player incorporates a special video decoder that’s able to read 
the unique “.avi” video files created by Morae Manager. Under the terms of your license, you can freely 
distribute Morae Player.!!

Component Why you use it

Recorder You use Recorder to set up a usability test (for example to define the tasks) and 
to create a digital recording of participants interacting with the product, web site 
or software.

Observer You use Observer to view a usability test in progress from another location and 
to flag any interesting behaviours that you see.

Manager You use Manager to analyse the results from a usability test and to prepare high-
lights videos.
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Lesson 2: Planning a usability test!

This lesson covers the steps you’ll need to take to plan your us-

ability test with Morae Recorder.!
!
“Planning is an unnatural process; it is much more fun to do something. The nicest thing about not planning is 

that failure comes as a complete surprise, rather than being preceded by a period of worry and depression.” — 

Sir John Harvey-Jones (1924 - 2008).!!
Before you launch Morae, you need to have a usability test plan in place. This will contain lots of informa-
tion that Morae doesn’t need to know about, and some that it does. Here’s what you need to tell Morae:!!
! A description of the study.!

! The list of test tasks.!

! The post-task and post-test surveys (if you use them). !

! The behaviours you want to log.!!
You enter this information via Morae Recorder’s “Modify Study Details…” dialog by pressing the button 
shown in Figure 1.!!
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Figure 1: The Morae Recorder window"

" !

Describing the study!
You describe the study in the first tab, titled “Description” (see Figure 2). The information you enter here 
will replace the title and description at the very top of the Morae Recorder window (“Default Study” in 
Figure 1). It will also be available to you in Morae Manager. This is useful when you open the study a few 
weeks later and completely forget what the test was about.!!
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Figure 2: The “Description” tab in the “Modify Study Details” dialog."

" !!
To describe the study: !
1. Enter a short title for the study in the “Study name” field.!
2. Write a description of the study in the “Study description” field.!
3. If you’re running a conventional usability test, you can leave the “Study Instructions” field blank. But if 

you’re running an unmoderated test, or if you want Morae to log the tasks for you, include some guid-
ance in the “Study Instructions” field. (See Lesson 5, titled “Running on AutoPilot”, for more informa-
tion about running unmoderated tests). Note that the text formatting controls at the bottom of the 
dialog can be used only on text entered in the “Study instructions” field.!

Defining the tasks!
The second tab, “Task Definitions”, lets you enter descriptions of the tasks (see Figure 3). !!
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Figure 3: The “Task Definitions” tab in the “Modify Study Details” dialog."

" !!
To enter the task details: !

! Click in the description field and type in a description.!!
Gotcha! Some people enter the full narrative task description that’s given to the test participant. Since 

the participant will never see this description, write something short instead — it’s just an aide memoire 
for you.!!
! If you’re using Morae’s Autopilot feature to run an unmoderated test (or to log the tasks), participants 

will need to see some written instructions. You enter the instructions for each task by clicking on the 
word “None” (it’s a hyperlink) in the field adjacent to each task. If you’re running a conventional usab-
ility test, leave this field blank.!!
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Quick Activity: Enter tasks 
Do you already have a usability test planned? If so, open Morae Recorder and enter a high-level descrip-
tion of each task you’ll be using. Alternatively, enter these four task descriptions. (These task descriptions 
are ones we’ll use to test the usability of Amazon). !!
Task 1: Find a book!
Task 2: Find an album!
Task 3: Find a movie!!
Then, delete the extra tasks (“Task 4” and “Task 5”) in the default configuration file.!!
Defining the success score!

Morae includes a “Success score” that you can assign at the end of each task. These can be edited just 
like the task details. I think Morae’s definitions are a little woolly, so in my studies, I use just two defini-
tions instead:!

Table 2: Alternatives to Morae's default success score."

!
Gotcha! The scale that’s used for success score in Morae Manager doesn’t match the way success score 

is measured in the usability profession. In usability, people talk of success scores as running from 0% (task 
failure) to 100% (task success). In Morae Recorder, success scores run in the opposite direction: from 0 
(“completed with ease”) to 2 (“failed to complete”) (see Figure 3).  Notice that in Table 2 I have changed 
the order of the definitions to reverse the way the scale runs, so that low numbers are bad and high 
numbers are good. (Bizarrely, you can’t edit the numbers themselves in Morae Recorder, you can only 
edit the definitions.) This change is important because it will help you head off a problem that occurs in 
Morae Manager when you analyse your data. Morae Manager allows you to draw a histogram of average 
success rate and if you retain Morae Recorder’s scale, then tall bars indicate task failure and small bars 
indicate task success. This is counterintuitive and could result in you misinterpreting your results.!!
Quick Activity: Success Score Descriptions 
Open Morae Recorder and replace the default success score descriptions with the ones shown in Table 
2.!

Setting up data logging!

Editing Recorder’s default markers!

Recorder supplies a set of default observation codes called “marker definitions” (see Figure 4). In my 
training courses, I find that these markers are responsible for causing more confusion than anything else 
in Morae Recorder. Unless you’re familiar with the concept of an ethogram, edit these prior to your 
study to just have one marker type.!

Definition Scale

Task failure 0

Task success 1
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Figure 4: The “Marker Definitions” tab in the “Modify Study Details” dialog."

" !!
This looks very similar to the “Task Definitions” tab and you can edit the descriptions in exactly the 
same way. !!
To edit the marker definitions: !

! Click on the existing description and replace it with your own description.!!
There’s an alternative to all these marker definitions that I use in my tests. Simply have one marker defin-
ition and call it an “Observation” (see Table 3).!

Table 3: A simple alternative to Recorder’s marker definitions."

!
Quick Activity: Marker Definitions 
Replace Recorder’s default marker definitions with the one shown in Table 3.!!

Type Definition

O Observation
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Setting up the post-test survey!
The final tab in the “Modify Study Details” dialog lets you define the survey you want to present to par-
ticipants to measure satisfaction (see Figure 5). You can present a different survey after each task as well 
as a survey at the end of a test. !!
Figure 5: The “Survey Definitions” tab in the “Modify Study Details” dialog."

" !!
My own view  is that usability questionnaires are a poor way to collect satisfaction data in usability tests. 1

However, Recorder does include one of the better surveys (the System Usability Scale). !!
If you want to use your own survey, Recorder provides some rudimentary controls for setting up a sur-
vey (see Figure 6). !
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Figure 6: The “Survey Definition” dialog in the “Survey Definitions” tab."

" !!
To create your own survey: !
1. Choose the “Survey Definitions” tab!
2. Click on the “Add” button.!
3. Give the survey a descriptive name (e.g. “End of test survey”). Note that participants will see your 

description in the title bar of the survey window so use something reasonably descriptive.!
4. Click on the “Custom questions” radio button.!
5. Click the “Add” button.!
6. Use the dialog box to create your question.!
7. Click “OK”. To create another question, click the “Add” button again.!
8. When you’ve finished adding questions, select “OK” to save and close the survey or “Preview” to re-

view your work.!!
Gotcha! When you preview the survey, you can’t type in the fields or check the behaviour of the con-

trols. The preview also labels the submit button as “Close”, which isn’t what the participant sees when 
the survey is presented (the button in the “live” survey reads, “Done”).!!
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Once you have created your survey, you need to tell Recorder when you want the survey to be presen-
ted. You can present a survey at three points: at the beginning of a recording; at the end of a recording; 
and at the end of a task (see Figure 7). !!
Figure 7: The “Survey Definitions” tab in the “Modify Study Details” dialog."

" !!
To present the same survey at the end of each task: !

! In the pull-down menu next to “Survey” (see Figure 7), select “End of Task 1”.!

! Click the “Copy” button. This duplicates the Survey as “Survey(2)”. Rename the survey if you want by 
clicking on its name in the list.!

! In the pull-down menu next to the copied survey, select “End of Task 2”.!

! Repeat these steps for all your tasks.!!
Why survey at the beginning of the recording? 
It may seem odd to solicit opinions at the beginning of a recording — after all, the participant hasn’t yet 
had a chance to form an opinion of your product, web site or software. In fact, this gives you a one-time 
opportunity to measure the participant’s expectations. You can then compare these expectations with 
participants’ actual experience. !!
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For example, you may find that at the beginning of a test, participants expect it to be “very easy” to find 
a company’s contact details on a web site but after completing the task most found it “very hard”. Com-
paring expectations against experience is important because it helps you prioritise your findings. This is 
because it’s more important to fix tasks that people expect to be easy but turn out to be hard than 
tasks that people expect to be hard and are in fact hard.!!
You could collect these measures by delivering a survey at the beginning of the test to ask participants 
how easy or difficult they expect the various tasks to be, and then following up with a survey after each 

task to measure actual difficulty. For more information on this approach, see Albert, W., and Dixon, E. 
(2003). “Is This What You Expected? The Use of Expectation Measures in Usability Testing”. Proceedings of 

Usability Professionals Association 2003 Conference, Scottsdale, AZ, June 2003.!!!
Quick Activity: Survey Creation 
Use Recorder’s survey creation tool to re-create this survey (based on: Lewis, J. R. ,1995. “IBM Computer 
Usability Satisfaction Questionnaires: Psychometric Evaluation and Instructions for Use.” International 

Journal of Human-Computer Interaction, 7:1, 57-78).!!
1. Overall, I am satisfied with the ease of completing the tasks in this scenario.!
2. Overall, I am satisfied with the amount of time it took to complete the tasks in this scenario.!
3. Overall, I am satisfied with the support information (online-line help, messages, documentation) when 
completing the tasks.!!
Note 1: Each question should have a 7-point scale (with end-points labelled “strongly disagree” and 

“strongly agree”).!

Note 2: Each question should have an associated text box so that the participant can explain his or her 

rating.!

Note 3: The survey should appear at the end of the test and at no other time.!!!
Expert tip: Saving your configuration as a template 
When you first launch Morae Recorder, you’re given the option of choosing a study configuration from a 
pull-down menu. This menu includes options like ‘Focus Group’, ‘Hardware or Mobile Device Study’ and 
‘Software or Web Usability Study’. Wouldn’t it be nice if you could save your own configuration as a 
template so that it was always available to you or so that you could share it with your team? Morae Re-
corder doesn’t provide the option of saving your configuration as a template, but it’s easy for you to do 
this. Simply save your configuration file in this folder: C:\Program Files\TechSmith\Morae\DefCfgTem-
plates. When you next launch Morae Recorder you’ll see your configuration file as one of the options in 
the list.!!
Planning a Usability Test: Checklist!
! Test study description entered into Recorder

! Short descriptions of test tasks entered into Recorder
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! Marker definitions (behaviour codes) defined

! Satisfaction survey created
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Lesson 3: The pilot test!

This lesson covers the steps you’ll need to take with Morae Re-

corder and Morae Observer before the first participant arrives.!
!
“Where observation is concerned, chance favours only the prepared mind.” — Louis Pasteur (1822 - 1895).!!
Before you run the first participant, you need to carry out a pilot test to identify and resolve any tech-
nical issues with the recording equipment. You’ll want to make sure that:!!
! The picture-in-picture camera is working.!

! You can record the computer desktop or from a second camera.!

! The microphone is working.!

! You can connect to the participant’s machine using Observer and view the test in progress.!

! You have told Recorder which data to you want to include in the recording.!

! You have sufficient disk space.!

Checking the picture-in-picture camera!
Assuming you have a webcam attached to your computer, you should see an image of yourself smiling 
back as soon as you open Morae Recorder (see Figure 8). If you can see this image (the picture-in-pic-
ture or “PiP” camera preview), take a few moments to admire yourself and then skip to the next step 
(“Checking the audio”).!!
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Figure 8: The Morae Recorder window."

" !!
If you see a grey box with a white “X” in place of your smiling countenance, this means Morae Recorder 
is having problems communicating with the webcam. The best way to troubleshoot this is to open the 
software that came with your webcam to check that the webcam is working properly. Alternatively, try 
re-starting your machine.!!
If you can see the video, you don’t need to do any further configuration unless you want to record from 
a video source other than the computer or if you want to activate certain specialised features of your 
webcam. For example, some webcams support face tracking: this ensures that the participant’s face is 
always centred in the window, even if he or she shuffles around. To access these advanced features, click 
on the wrench icon next to the “PiP” pull-down menu (see Figure 9).!
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Figure 9: The “PiP Camera Settings” dialog."

" !!
This opens the “PiP Camera Settings” dialog (Figure 9), which allows you to configure your camera to 
your heart’s content.!!
Quick Activity: Exploring your camera 
Open the “PiP Camera Settings” dialog by clicking on the wrench icon. Find out if your webcam has any 
snazzy extras like face tracking.!

Multi-camera setup!
The main reason most people use Morae is to record the computer screen along with the picture-in-
picture (PiP) video. This feature has always been a key part of Morae but it meant that you could use 
Morae to test web sites or software only.  But you can also use Morae to record from a video source 
other than the computer desktop. This feature means you can use Morae to record, remotely observe 
and log usability tests of anything, such as a mobile phone or a paper prototype. If you can point a camera 
at it, you can use Morae to test its usability.!!
To record from a second camera: !
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1. Connect your second camera to the computer (for example, via USB or Firewire).!
2. Under “Video and Audio Sources”, select your second camera in the pull down menu labeled “Main”.!!
Expert tip: Configuring the camera view 
When you’re setting up your second camera to record from a paper prototype, it’s sometimes hard to 
set up the camera so that it doesn’t get in the way of the participant. If you can’t ceiling-mount your 
camera, place the camera on the opposite side of the participant. This means you get an upside-down 
view of the prototype, but you can then “flip” the view in the “Camera Settings” dialog (see Figure 9) to 
turn it back the right way for recording. !

Checking the audio!
Just above the video preview window on Recorder’s “home” screen (see Figure 8), you can see an unla-
belled cyan and red horizontal bar. Say out loud, “1,2,3, usability testing is for me!” and you should see 
the bar fill up with light blue and orange. If it does, you can skip to the next step, “Making a test record-
ing”.!!
If the volume bar isn’t moving, or if it’s hardly moving, boost the audio by using the horizontal slider 
(move it to the right to make it louder; see Figure 8).!!
Gotcha! When you close and re-open Recorder, it will sometimes “forget” the audio device you selected 

and revert back to its default (usually the webcam audio). So if you don’t want to use the webcam audio 
— for example, if you’re using a high-quality USB mic — be warned that Recorder may forget your pre-
vious selection and you may need to re-select it next time you open Recorder.!

Making a test recording!
Finally, we’ll just check that everything is working OK by running a test recording. Click on the “Test Re-
cording” menu item (see Figure 8) and start performing for the camera. The Recorder window will close 
and the software will make a 15-second recording from the video sources you’ve selected. !!
It’s important to check that the audio level is right, so speak at a conversational level while you browse 
around your desktop.!!
Recorder plays back the test recording immediately. If you can see and hear yourself, we’re ready to 
move to the next step.!!
If the sound quality is poor (with lots of hissing and clipping) you may have run into an unusual (but 
known issue) with the first release of Morae 3.0. In that case, you should upgrade (for free) to Morae 3.3. 
To upgrade, select “Check for Upgrade” from the “Help” menu.!!
Quick Activity: Make a test recording 
Carry out a test recording to check your set up is working correctly.!
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Connecting to the test machine with Observer!
If you want to observe the test in progress from another room or in the same room, then you need to 
make sure you can connect to the test machine with Morae Observer. You don’t have to do this step: I’ve 
run many tests where I’ve simply run Recorder on one machine and then transferred the files into Man-
ager for data analysis. But if you can get someone to observe, it’s worth it since you can usually arm-twist 
that person into being a datalogger for you, which will save you a lot of analysis time.!!
In my experience, connecting Morae Observer and Morae Recorder over a network usually “just works”. 
The problem is that when it doesn’t “just work” it can be a nightmare to troubleshoot. So try these 
simple steps and if it doesn’t just work, call in the network cavalry.!!
To connect to the test machine from another computer: !
1. Make sure that both machines (the test computer and the observation computer) are connected to 

the same network.!
2. Make sure Recorder is open on the test computer. Have someone sit in front of the test computer 

and talk to himself or herself (alternatively, turn on a radio).!
3. Press the “Click to start recording” button on the test computer.!
4. Walk along the corridor to the observation computer.!
5. Launch Observer on the observation computer.!
6. Click on the “Browse Network…” button on the observation computer and navigate to the test ma-

chine (see Figure 10).!

Figure 10: The “Connect to Recorder” dialog in Morae Observer"

" !!
7. If you’ll be observing the test from the same room (for example, if you’re both moderating and data-

logging) then select the checkbox, “Mute audio to minimise time lag”. If you’ll be observing the test 
from a different room, then leave this unchecked.!

8. Click Connect.!
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9. Check you can see the screen of the test computer, see the video and (if you’ve deselected the “High-
est streaming quality” option) hear the audio.!!

If you are inside a corporate intranet, you may see dozens of machines when you click on “Browse Net-
work…” In that case, it’s probably quicker to type in the IP address of the test computer.!!
To find out the IP address of the test computer:  
1. On the test computer, choose “Start > Control Panel”.!
2. Choose “Network Connections”.!
3. Double-click the network connection that you’re using. !
4. Click on the “Support” tab.!
5. Note down the IP Address (for example, 10.0.1.188).!!
(If you’re familiar with DOS, an alternative way to find your IP address is to type “ipconfig” at the DOS 
prompt).!!
You’ll find that this recipe works almost every time. If you’re still unable to connect to the test computer 
from the observation computer after following these instructions, try “Troubleshooting Observer con-
nection issues” at the TechSmith web site: http://www.techsmith.com/learn/morae/2/observing-and-log-
ging/troubleshooting-observer-connection-issues.asp. It’s a terrific little troubleshooting tool and will 
almost certainly fix your problem.!

Two kinds of observation!

You’ll notice from Figure 10 that Observer offers you a checkbox, “Mute audio to minimise time lag”.!!
This option is really about reducing the video delay you will experience when viewing the test with Ob-
server. If you leave the “Mute audio to minimise time lag” checkbox unselected, there will be a buffering 
delay of at least 6 seconds (probably more, depending on your network), but the quality of the video will 
be very good. If you are not in the same room, or in a separate location all together, the buffering delay 
doesn’t matter. So this option allows you to view a high quality video stream.!!
The checkbox is really there for times when the video delay is a problem: for example, if you are using 
Observer in the same room as the participant or if you are seated in an observation room where you 
can still see the participant. In these scenarios, you need a video stream that is much closer to real time, 
otherwise the delay can be very frustrating. !!
“Mute audio to minimise time lag” selected. There will be no delay in what you see on the computer 

running Observer. When the participant clicks with the mouse, you see it instantly on the Observer 
computer, just as if you were looking over the participant’s shoulder. You also see the webcam view of 
the participant as he or she grimaces (or smiles) when using your software — although the video image 
may be a bit jerky depending on the local network traffic. (If this bothers you, turn off the picture-in-pic-
ture view of the participant by choosing “View > Picture in Picture (PIP)” in Observer. You may also find 
this improves overall performance). The price you pay for the real-time view is that you can’t hear what 
the participant is saying, so use this option only if you are in the same room as the participant or if you 
have an alternative audio feed (such as in a professional usability lab where you can see the participant 
through a 2-way mirror and hear the participant through a built in audio system). !!
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“Mute audio to minimise time lag” deselected. With this option, you’ll hear what the participant is 

saying but you’ll get a delay between the two computers. This delay is usually around 6 seconds or so. 
The audio and video image are still synchronised with each other, it’s just that they are both out of sync 
with reality. If you use this option when you’re in the same room as the participant it will drive you mad, 
so use it only if you can’t see the participant.!!
Table 4 lists various types of usability testing situation  and tells you if you should or should not mute 2

audio for each one. Some of the situations depend on whether the connection between the Observer 
and Recorder computer is over a high bandwidth (wired Ethernet) connection or a lower bandwidth, 
wireless connection.!!
Table 4: Matching your situation to the two Recorder options."
Your situation Setting for “Mute audio to min-

imise time lag” checkbox
Portable test lab: The moderator takes the test to the participant 

and sits at the participant’s desk or cubicle. If observers are 
present, they squeeze in and sit where they can. Morae Observer is 
running on the moderator’s laptop so that he or she can log the 
test.

Selected

Single room setup: The moderator and participant sit at a desk in 

a small office. Observers sit at the back of the room and watch the 
test on a separate computer that is running Morae Observer. Ob-
servers are close enough to hear what the moderator and parti-
cipant say to each other.

Selected

Large single room setup with microphone: The moderator and 

participant sit at a desk at the front of a large conference room. 
Observers sit in the room and view the participant’s screen projec-
ted via Morae Observer on to the front of the wall (using a data 
projector). The moderator and participant both wear microphones 
so that the observers can hear the dialogue. 

Selected

Large single room setup with headphones: The moderator and 

participant sit at a desk at the front of a large conference room. 
Observers sit at the back of the room and view the participant’s 
screen on a laptop and listen to the session through headphones 
connected to the laptop.

Selected

Classic testing lab setup: The moderator and participant sit in 

one room. Observers can see the moderator and participant 
through a one-way mirror and hear their conversation through the 
lab’s built-in audio system. Observers get a close-up view of the 
participant’s screen via Morae Observer on a large flat-panel dis-
play. 

Selected
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Defining capture options!
By default, Morae Recorder will record the webcam video and audio, all keyboard entry, all mouse clicks 
and all text that appears on the screen. These are sensible defaults and unless you know what you are 
doing, you should stick with these defaults.!!
One useful set of options that is not turned on by default is Morae’s ability to indicate mouse clicks by 
showing on-screen highlight colours. This provides useful visual feedback to people watching the remote 
recording and also enhances video highlights. The highlight colour helps observers to see where the 
mouse is pointing and to see when the mouse is clicked. (Nothing changes on the participant’s screen, 
this is just to help remote observers see what is going on). You can’t enable this feature once the record-
ing has been made and it’s so useful I recommend you do it now. !!

Multi-room setup: The moderator and participant sit in one room. 

Observers sit in another room elsewhere in the building. Observ-
ers watch the participant’s screen via Morae Observer projected 
on the wall and hear the participant through the computer’s speak-
ers.

Deselected

Internet setup: The moderator and participant are in one office 

location. Observers are in another location and use Morae Ob-
server to view the test over a VPN or the Internet. 

Deselected

Remote unmoderated test: The participant works alone with the 

computer in a kiosk-based configuration (see Lesson 5, “Running 
on AutoPilot”). The computer presents the tasks to the participant 
and the participant signals when he or she has completed the task. 
Observers are in another location and use Morae Observer to 
view the test over a network or over the Internet.

Deselected

Your situation Setting for “Mute audio to min-
imise time lag” checkbox
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To highlight mouse clicks on screen: 
1. Choose the “Modify Recording Details” button from the main screen of Morae Recorder (see Figure 

8). This opens the “Recording Details” dialog.!
2. Select the “Capture Options” button (see Figure 11).!
3. Select all of the checkboxes under the “Mouse clicks” checkbox, then choose “OK”.!

Figure 11: The “Capture Options” tab in Morae Recorder lets you highlight mouse clicks on screen."

" !!
Expert tip: Don’t record keystrokes 
You’ll see from Figure 11 that there are three checkboxes on the right-hand side under the “Data” head-
ing: “Mouse clicks”, “Keystrokes” and “Screen text”. These are the data that Morae will record by default, 
and virtually everyone leaves these items selected. !!
However, you might want to think twice about logging keystrokes. It’s not unusual to ask participants to 
sign in to their account, which requires them to enter a password. Or participants may need to create a 
password to complete a task and think that the password is hidden. If you log keystrokes then you will 
capture every keypress that the user makes, irrespective of its visibility on screen. This might put you in 
an awkward position if a participant’s account details are later compromised. I’ve never run a study 
where we counted or searched for keystrokes, so unless your study requires it, I strongly recommend 
unchecking the “Keystrokes” box. Note: You’ll still be able to search recordings for any text entered by 
participants, unless the text is hidden (such as in a password field), because you’re still recording the 
“Screen text”.!

!
Checking disk space!
Gotcha! There’s one extra check you’ll want to make before proceeding to the next step: make sure you 

have enough disk space on the participant’s machine to save the recording file. Morae doesn’t handle this 
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situation very well and if you run out of space you’ll lose your recording. The amount of space you need 
will vary from study to study (it’s influenced by a range of factors including the screen resolution, the 
amount of animation or video on the screen, the number of real-world images, the resolution of the 
webcam and the length of the test). The Morae manual states that you should expect to use 10-15 MB 
per minute while recording a participant session. That fits with my experience: for a typical 90-minute 
session, I find that participant files are usually a little short of 1 GB. So make sure you have this much 
free space before running a participant. If you’re about to run an 8-participant study, scale up accordingly.!

The Pilot Test: Checklist!
! The camera is working.

! The microphone is working.

! The observation computer can connect to the test computer over the network.

! All of the “highlight mouse click” options are enabled.

! There is enough free disk space for the recording.
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Lesson 4: The usability test!

This lesson covers the steps you’ll need to take to run the usabil-

ity test with Morae Recorder and Morae Observer.!
!
“If I had asked my customers what they wanted, they would have asked for a faster horse.” — Henry Ford (1863 

- 1947).!!
By this stage, we’ve planned the test and know the technology is working fine. Now we just need to col-
lect the data. Here are the steps you need to take:!!
! Greet the participant.!

! Start the recording.!

! Code the participant’s behaviour.!

! Save the recording file.!

Greeting the participant!
This is a guide to using Morae, not about usability test moderation. So I’m not going to tell you how to 
welcome a test participant, but I do want to tell you a few things that relate to using Morae.!!
! When the participant enters the room, make sure that the computer display is turned off. You want 

the participant focussed on you, not the screen.!

! Minimise Morae. Otherwise, when you turn the computer screen back on, the participant will see him 
or herself staring back. This has been known to cause some participants to freak out. !

Starting the recording!
Ask the participant to provide informed consent before you start the recording. Then, the easy part:!!
To start recording: 

! Either right-click the Morae icon in the system tray and select, “Start” from the pop-up menu.!

! Or press the big red button at the top of the Recorder screen. The Recorder window will disappear 
and a “video camera” icon will appear in the system tray.!!

If the participant is sitting next to me, I prefer the first option as it means I can keep Morae minimised, 
hiding the recording interface from the participant. !!
What is “informed consent”?  
Before recording a participant’s session, you have an ethical duty to ask for “informed consent”. !!
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Informed consent means that the participant understands exactly how you intend to use the recording. For 
example, if you were a participant in a test, you would probably be happy for your session to be re-
viewed by the design team. But would you be happy for a video clip to be shown outside the design 
team, for example to people in marketing? How about at a public conference like UPA or CHI? Or up-
loaded to YouTube? Now imagine that it’s a usability test of your Intranet — how would you feel if a 
video clip showing you struggling with the Intranet was shown to senior managers in your company?!!
It’s rare for a participant to refuse consent — I’ve run hundreds of sessions and I’ve had only two parti-
cipants refuse — but when it happens, you need to agree with the participant what can be recorded and 
what can’t. Some participants don’t want to be videoed, so you should turn that option off in Recorder’s 
“Capture Options” tab (see Figure 11). In addition, some participants may not want you to record their 
voice, so you’ll have to turn that option off too. The worst situation is when the participant doesn’t want 
you to capture the screen action: in this case, you’ll have to stop the recording and not save the file. (You 
can still run the test: you’ll just have to take good notes and ask any remote observers to come to the 
room to watch the session). !!
One way to minimise this problem is to warn people that you want to record the session when you 
recruit them and explain why you are making the recording. That way, people won’t be surprised when 
you ask for their consent and they are much more likely to agree. 

Coding the participant’s behaviour!
Elsewhere in the building, a colleague — perhaps you — will be observing the usability test with Morae 
Observer. This person is called the “datalogger”. !!
As the datalogger, you will have access to the marker definitions you set up earlier (see Table 3). As you 
watch the test, you should note down the participant’s behaviour and make observations. Remember 
that an observation is something that you see or hear: it’s not your interpretation of why the problem 
has occurred or your idea for how to fix it.!!
As a rule of thumb, the datalogger should average about one observation per minute. But remember this 
is an average: observations are a bit like buses (none for ages, then three come along at once).!!
Expert tip: How to moderate and log simultaneously 
What if you don’t have a datalogger? For example, what if it’s just you and the participant — how can 
you add markers and log tasks? !!
If you want to log events and are less bothered about adding notes, then the best solution is to use a Wii 
Remote. With this feature, you can record and log simultaneously using just one computer. You first need 
to go through the process of pairing a Wii Remote with a Bluetooth-enabled computer but once that’s 
finished you can use the buttons on the Wii Remote to log tasks and events. !!
If you also want to add notes with your markers, the simplest solution is to run Morae Observer on a 
laptop and type into it as the participant works. However, this makes is difficult to build rapport with the 
participant since your laptop will create a physical barrier between you both. Another problem is that 
you inevitably focus on your screen rather than the participant’s and this means you may fail to observe 
something important.!
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!
An alternative solution is to connect a mini Bluetooth keyboard to the laptop running Morae Observer. 
You can then place this computer out of the way and just balance the keyboard on your lap. Just tell the 
participant that you’ll be using the keyboard to make brief notes during the session.!!
Because you won’t easily be able to see the screen of the computer running Morae Observer, all these 
methods require you to know your observation codes off by heart (that’s another reason why I recom-
mend you just have one code: the ‘O’ for Observation). If, despite my encouragement, you want to have 
multiple marker codes then one solution is to put coloured stickers on the keyboard or Wii Remote. 
Another solution is to just log the start and end of tasks (with Alt-S and Alt-E) and note usability issues 
(with Ctrl-X). In either case, you’ll have saved yourself a significant amount of time when it comes to 
doing the analysis.!!
Finally, if you’re running a paper prototype test, Morae is pre-configured to let you moderate and log 
simultaneously. So long as your main video source (see Figure 8) is set up to be a camera (i.e. not the 
screen), then Morae Recorder will transmogrify into Morae Observer when you start the test.!

Why making observations is important!

Many novices to usability testing just sit through a test and don’t take good notes. As you watch the test, 
you should make observations. Here’s why:!!
! Good “live” observations save hours in analysis time because you won't need to re-watch the video 

recordings.!

! When lots of observations come at once, you will be able to just log the observation (“O”) — you 
can then review these later in Manager.!

! It’s one of those things you’ll be glad you did when there are problems with the video recording (for 
example, when the sound is poor).!!

Jargon alert: Morae uses the term “Marker definition” instead of observation code.!!
During the test, you can note observations in Observer in one of two ways:!

! Type the marker letter, for example, “O” to add an “Observation” marker.!

! Type CTRL and the spacebar simultaneously. This adds an undefined marker.!

! Click the marker definition in the marker definition window.!!
This adds a new line to Morae Observer’s marker log file (see Figure 12).!

Figure 12: The marker log file in Morae Observer."

" !!
Note for lazy dataloggers: As a minimum, you need to log the start and end of each task (using “Alt+S” 

and “Alt+E”), since Morae Manager needs to know which part of the recording refers to which task so it 
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can calculate its usability statistics. If you don’t log the tasks now, you’ll have to do it later when you im-
port the recordings into Morae Manager.!!
How do I pause the recording? 
Sometimes you may want to pause the recording: for example if the participant needs a break or if a 
technical issue crops up with the web site or software under test. You’ll notice a “Pause” button in Figure 
12, but this doesn’t pause the recording — it just pauses the timer that’s recording the time on task. 
(The “Pause” button only appears during a task; if you’re not in the midst of a task then the button reads 
“Start Task”).!!
Morae Recorder doesn’t provide a way to pause the recording, and because of the way Morae treats 
recording files (see below) it’s best just to continue with the recording. So if you’re in the midst of a task 
when you need a break, click on the “Pause” button and add a short note at the point where the task is 
interrupted. Then restart when you’re ready (the “Pause” button will now read “Resume”). Morae will 
then ignore this part of the task when you open it in Manager and analyse performance on this task. !!
If you stop and save one recording (for example, “P1 - Part 1”) and then start a second recording after 
the break (for example, “P1 - Part 2”), Morae will treat the two recordings as two different participants 
in its analysis. Because Morae doesn’t allow you to merge participant recordings, this will make it a bit 
harder for you to understand Morae’s graphs: you’ll have to keep reminding yourself that recording “P1 - 
Part 1” and recording “P1 - Part 2” are actually the same participant. !

Saving the recording file!
At the end of the session, you need to stop the recording. I suggest waiting until the participant has left 
the room — it doesn’t look very professional when you’re faffing around with the technology and your 
participant is waiting for his or her incentive. You can always trim unwanted silence from the end of your 
recording when you create a video in Morae Manager. !!
To stop the recording session: 

! Double-click the Morae Recorder icon in the task bar (see Figure 13). !

! Press the blue button labelled “Click to stop recording” (see Figure 14).!

Figure 13: Stopping the recording session (part 1)."

" !!
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Figure 14: Stopping the recording session (part 2)."

" !!
Once the session has stopped, you’ll be presented with the “Recording File Details” screen (see Figure 
15). This is where you name the file. I like to use something anonymous but descriptive like “Participant 
1”. You can add comments in the “Description” field if you want to, but this is optional. !
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Figure 15: The dialog that appears when you stop the recording."

" !!
You’ll see two checkboxes:!

! “Password protect recording file”: This lets you protect the file from prying eyes. This is useful to pro-
tect the secrets of your client and the privacy of your participant. If you work for the Government 
and leave your laptop on a train, no-one will be able to import the recording into Morae Manager 
unless they know the password. And if your participant has been entering passwords, credit card 
numbers or other personal data, you have an ethical obligation to secure the file.!

! “Defer final processing”: This lets you postpone the writing out of the file until later. Writing out the 
file can take a few minutes, so this is a useful option if your participant ran slightly late, your next par-
ticipant has already arrived and you just want to get on with the next session.!!

Quick Activity: Run a usability test 
In this activity, you’ll run a usability test with Morae. To begin, find a colleague who’s happy to take part in 
your test. !!
Set up the participant’s computer 
Start Morae Recorder using the configuration file you created earlier.!!
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Set up the moderator’s computer 
Open Morae Observer and connect to the participant’s computer, selecting the checkbox “Mute audio 
to minimise time lag” (see Figure 10). Including audio will create a video delay and isn’t necessary as 
you’re sitting next to the participant.!!
Run the test 
If you’re following along with my example, send the participant to Amazon’s web site. Then carry out the 
following tasks:!!
Task 1: “How many pages are there in the book, ‘Don’t Make Me Think?’ by Steve Krug?”!
Task 2: “What’s the title of Track 6 on the Beatles album, ‘Sgt Pepper’s Lonely Hearts Club Band’?”!
Task 3: “How long is the movie, ‘Vertigo’, directed by Alfred Hitchcock?”!!
Log the test including the “Start” and “End” of each task (remembering to select the correct task from 
the pull-down menu in the log!). At the end of the two tasks, stop the recording and save the file (use the 
participant’s first name and surname initial as the file name, for example, “DavidT”). !

The Usability Test: Checklist!
! Make sure the video preview in Recorder is switched off before the participant arrives.

! Start the recording once the participant has given consent.

! Observe and log behaviours using Observer.

! Save the recording file.
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Lesson 5: Running on AutoPilot!

This lesson describes how Morae can help you run an unmoder-

ated usability test.!
!
“I have a lot of trouble with your remote controls. Too many arrows.” — HRH Queen Elizabeth II, speaking to 

Sony’s CEO Howard Stringer.!!
The approach to usability testing that we’ve described in previous lessons characterises the vast majority 
of usability tests that people carry out. In particular, the moderator and the participant are co-present: if 
not in the same room then at least in adjacent rooms. If this set-up captures the way you carry out tests, 
then you can skip this chapter entirely.!!
But what if you would like to run tests with participants who can’t come to your testing facility? In re-
cent years, there has been an interest in unmoderated usability tests: tests that “run themselves”. The idea 
is that the computer moderates the test: it shows the participant the software or web site that’s being 
tested along with a control panel with task instructions. If you need to get access to lots of participants 
quickly, you could run this type of test in a kiosk in a public building. !!
Morae 3.0 introduced a new feature called “AutoPilot” that supports this kind of testing. Not to be con-
fused with pilot testing, AutoPilot is a suite of functions for presenting test tasks to participants. It’s a bit 
like a “Usability Moderator in a Box”. In addition to presenting the tasks, AutoPilot also includes a con-
trol panel that the participant uses to step through the tasks. AutoPilot cleverly uses these controls to 
log the start and end of each task automatically. AutoPilot also supports remote observation, so you can 
drop in on your test and see how it’s progressing.!

How it works!
The best way to understand the way AutoPilot works is to imagine yourself as a potential participant. 
Figures 16-18 show the steps in the process, once you’ve started a session with Morae Recorder. !!
Imagine that you’re walking past a computer set up on a spare table in your office canteen. You see the 
screen shown in Figure 16.!

Figure 16: AutoPilot draws in the participant"

" !
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Interested to find out more, you click on the “Start” button and read the following text.!

Figure 17 AutoPilot presents the first task"

" !!
Curious, you click on the “Start Task” button and carry out the task.!

Figure 18 AutoPilot gets out of the way"

" !!
There are clearly some limitations to this kind of testing — not least of which is how to keep the parti-
cipant on task — but for some applications in some contexts it offers a great way to collect usability 
data.!

How to set up an AutoPilot test!
The easiest way to set up an AutoPilot test is to launch Morae Recorder and choose the “Unmoderated 
Usability Study” option from the pull-down menu (see Figure 19).!
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Figure 19: The “Study Configuration” dialog"

" !!
This gets us part of the way there. We now need to add our tasks and descriptions. It’s absolutely critical 
to get these right, because the computer will be doing the moderating for us so we need to be as clear 
as possible.!!
To set up an AutoPilot test: 
1. Choose the “Modify Study Details” button from the main screen of Morae Recorder (see Figure 8). 

This opens the “Description” tab of the “Study Details” dialog (see Figure 2).!
2. Enter the initial instructions that you want the participant to see in the “Study Instructions” field (see 

Figure 16 for an example). The participant will see these instructions only once, when he or she first 
looks at your computer screen and decides to interact (or to leave). So make them engaging. “Hey, 
you! Take a test!” is probably a bad example.!

3. Choose the “Task Definitions” tab and click on the “None” hyperlink in the “Instructions” column for 
the first task. !

4. Enter a shorthand description of the task (for your reference) then, in the box labeled “Instructions”, 
enter the task scenario (Figure 17 shows an example of how these instructions will look to the par-
ticipant). !

5. Repeat for all tasks.!!
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AutoPilot: An Ethical Dilemma 
Since you won’t be sitting next to participants when they take the test, how will you ensure that you 
have their consent to record the session?!!
You then need to install the computer in a place where your participants will use it. For example, if 
you’re testing an Intranet, you could place it in the staff canteen. If it’s a web site, you could have AutoPi-
lot running on a machine in Starbucks and encourage coffee drinkers to pass by and take the test in ex-
change for a Double Chocolate Chip Creme Frappuccino. If it’s software you’re developing for a specific 
client, you could leave the software running in a break room with an invitation to users to take a look at 
it. The possibilities are endless.!!
Expert tip: Using AutoPilot as your task logger 
In Lesson 4 we discussed ways of moderating and logging tasks at the same time. Since AutoPilot auto-
matically logs tasks, you could use AutoPilot during a conventional, moderated usability test as your task 
logger. This isn’t a perfect solution, since the AutoPilot control window will remain on screen during the 
test, but may be worth considering if the other techniques I suggested don’t work out for you.!

AutoPilot: Checklist!

!!

! Enable AutoPilot by creating a new study configuration based on an Unmoderated Usabil-
ity Study.

! Write a persuasive introduction to the test.

! Enter the detailed task scenarios for each task.

! Find a suitable location for the test.
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Lesson 6: Identifying usability prob-

lems!

This lesson covers the steps you’ll need to take with Morae Man-

ager to find the usability problems in the data you’ve collected.!
!
“A designer knows that he has achieved perfection not when there is nothing left to add, but when there is noth-

ing left to take away.” — Antoine de St-Exupéry (1900 - 1944).!!
From now on we’ll be working solely with Morae Manager, since this is the part of Morae that analyses 
the data and allows us to present the results. You should have imported all of your participant recordings 
into Morae Manager. !!
Gotcha! Don’t install Morae Manager on just any old machine you have lying around. Like any software 

that edits digital video, it’s a real resource hog. So make sure you run it on the highest spec computer 
you can find (unless you enjoy looking at the Windows’ “wait” cursor).!!
To create a new project and import recordings: 

! Open Morae Manager and choose “Create a new project” from the “Welcome to Morae” dialog. Al-
ternatively, if Morae Manager is already open, choose “File > New > Project…”!

! Choose “File > Import > Recording…” (or type Ctrl-I), navigate to your recording, and import it.!

Cleaning up the behavioural observations!
Behavioural data can be messy. For example:!!
! The datalogger may not have had time to enter a full description, or any description, to explain the 

observation. !

! Issues may have cropped up with later participants that might cause you to go back and re-examine 
the sessions from earlier participants.!!

Ideally, you should inspect all of the observations for correctness. This is to make sure that you don’t 
miss any usability problems — an under pressure datalogger may have flagged a usability problem but not 
had time to describe it.!!
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Discussion: What makes a good usability problem description? 
Your usability problem description needs to be both useful and usable. I suggest you use the following 
format:!!
Describe the problem objectively. For example, “The participant does not understand the “pro” and 

“lite” labels used to distinguish the different versions of the software.”!!
Explain the consequences of the problem for those users who experience it. For example, “Users 

who experience this problem stand a 50-50 chance of downloading the wrong version”.!!
Molich et al. (2007) provide the following additional guidelines for writing useful and usable problem de-
scriptions:!
- Do as you preach. Show a good example by making your usability recommendations useful and usable.  !
- Communicate each recommendation clearly at the conceptual level. !
- Ensure that the recommendation improves the overall usability of the application. !
- Be aware of the business or technical constraints. !
- Show respect for the product team’s constraints.  !
- Solve the whole problem, not just a special case. !
- Make recommendations specific and clear. !
- Avoid vagueness by including specific examples in your recommendations.!!
Molich, R., Jeffries, R. and Dumas, J.S. (2007) “Making Usability Recommendations Useful and Usable”. 

Journal of Usability Studies, 2 (4): 162-179.!

How to find and review the observations!
1. Select the “Analyse” tab or choose “View > Analyze tab”!
2. Select “Search > Modify Search…” or click the “Modify Search” button or type “Ctrl-R” (see Figure 

20).!

Figure 20: The “Search Editor” dialog allows you to search the recordings."

" !!
3. Deselect all checkboxes except “Markers” in the “Search for” pop-up window.!!
The search results window will then list all of the observations. Double-click each of the search results 
in turn to listen to the recording and review the problem. Then, for each problem:!!
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1. Right-click on the problem in the search results window and choose “Properties…”  This opens the 
“Marker Details” dialog (see Figure 21).!

2. Read over the text note (if one exists) and describe the usability problem appropriately. Make sure 
your description is both useful and usable since it will be distributed verbatim to the development 
team.!

Figure 21: A correctly completed “Marker Details” dialog."

" !!
Scoring the usability problems. You’ll notice that I don’t recommend “scoring” the usability problem in 

this workflow. In my experience, it’s best to postpone a decision on severity until you have reviewed all 
of the usability problems for all of the participants. This is because you would normally classify a usability 
problem as more severe if it affects a large number of participants than if it only affects one or two par-
ticipants. So I recommend two passes: first, you find and review the usability problems for each parti-
cipant; then go back over the usability problems for all participants and rate the severity of each one. (It 
may even be better to do this outside of Morae, for example by exporting the observations to Excel).!!
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Quick activity: Clean up your data 
In this activity, you’ll create a new project in Morae Manager, import the session that you moderated into 
the project and then review and describe all of the usability problems.!!
Start a new Morae project and import the recording 
Follow the instructions at the beginning of this lesson if you need help with this.!!
Review and describe the observations 
Search for the observations (see “How to find and review the observations” above) and review each of 
the observations in turn. !!
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Lesson 7: Measuring usability!

This lesson covers the steps you’ll need to take with Morae Man-

ager to quantify the usability of the software or web site you 

have tested.!
!
“If you know a thing only qualitatively, you know it no more than vaguely. If you know it quantitatively — grasping 

some numerical measure that distinguishes it from an infinite number of other possibilities — you are beginning 

to know it deeply. You comprehend some of its beauty and you gain access to its power and the understanding it 

provides.” — Carl Sagan (1934 - 1996).!!
Usability is often thought of as a “soft” attribute — something intangible and difficult to pin down. In the 
past, usability was often assessed by asking people if they liked a product, or if they felt it was easy to use. 
Those days are over. The three critical elements of usability — effectiveness, efficiency, and satisfaction — 
can be operationalised and they can be measured, just like any other attribute of a product or system.!!
Here are the steps in using Morae to measure usability:!!
! Log each task.!

! Choose the most appropriate usability metric.!

Logging each task!
Before Morae Manager can calculate statistics for us, we need to tell Morae Manager which parts of the 
recording refer to which tasks. The person who did the datalogging should have already logged the be-
ginning and end of each task, in which case you just need to check that the start and end points are in 
the right place. If the datalogger didn’t log the tasks properly, demonstrate Morae’s “AutoPilot” function-
ality and point out that a computer could soon be doing his or her job in the future.!!
If the datalogger has marked the beginning and end of each task: 

! In the “Analyze - Project” window, select the first participant’s recording.!

! Click on the “+” icon to reveal the logged tasks, and select the first logged task.!

! Check that the start and end points are correct.!

! Right click the task and select “Edit Properties…”!

! Enter the task details in the dialog window. As a minimum, you should enter or confirm the task (for 
example, “Task 1”) and the score for this task (see Table 2 for more information about scoring tasks).!!

If the datalogger has not marked the beginning and end of each task: 

! Locate the beginning of the first task and press the “Set selection start” button (or select Ctrl-J).!

! Locate the end of the first task and press the “Set selection end” button (or select Ctrl-K).!
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! Press the “Log task” button (or select Ctrl-T).!

! Enter the task details in the dialog window. As a minimum, you should enter the task (for example, 
“Task 1”) and the score for this task.!

Choosing the most appropriate usability metric!
Morae puts all of the analysis options in the “Graph” tab. Perhaps “Analyze” would have been a better 
choice, but this was already taken. I also suspect TechSmith wanted to show off their new graphing cap-
abilities, hence the title. If you’re more familiar with Excel’s graphing functions you’ll be pleased to know 
that Morae also makes it easy for you to export your data to Excel. Once you’ve got the analysis you 
want, right click on the graph and chose “Export As > Data…” Then you can use Excel to plot your data 
any way you want.!!
The simplest way to start on your analysis is to switch to the “Graph” tab, click on the button, “Create 
new graph” and then click the button labelled “Select an analysis type” (see Figure 22). You then get a 
choice of six different analyses.!

Figure 22: Morae’s analysis tools"

" !!!
Let’s look at each of these analyses in turn.!

Application analysis!

This option contains two separate analyses:!

! Time spent in specific application(s)!

! Time spent in specific window(s) or dialog(s)!!
If you mainly test web sites, neither of these analyses will hold much interest unless your web site has 
lots of pop-up windows — which of course it won’t because you already know that pop-ups are con-
fused with advertising, making them one of Jakob Nielsen’s “Top ten web design mistakes” . !3

!
Time spent in specific application(s) could be a useful metric if you’re carrying out a field study and 

want to work out how long people spend using different software programs. !!
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Time spent in specific window(s) or dialog(s) could be useful if you’re testing a software application 

and you want to explore the parts of it where people spend most of their time. You could also use this 
option to work out how long participants spend reading help (type in the title of the “Help” dialog win-
dow in the pop-up dialog). Unfortunately, Morae doesn’t include a list of all of the dialog window titles 
(for example, in the way that elsewhere it lists the applications that were running) so you need to know 
ahead of time the titles of the dialog boxes.!

Input Device Analysis!

This analysis option contains three separate analyses focussed on participants’ use of the mouse and 
keyboard. !

! Maximum time in between inputs!

! Mouse clicks!

! Mouse movement!!
Maximum time in between inputs calculates the longest period that participants spent without inter-

acting with the computer. But it’s not easy to interpret this measure. For example, does a long interval 
mean that the user is engaged with the content (for example, reading it)? Or does it mean that the user 
is confused (trying to work out where to click)? However, if you view the data “By participant” it might 
help you identify a particularly slow participant.!!
Mouse clicks is a measure that is often used as a good proxy for time on task. In my studies with Morae, 

I’ve always found mouse clicks and time on task to be very highly correlated (with correlations well in 
excess of 0.9) but you should be aware that some commentators claim that the number of clicks isn’t 
what is important to users, but whether or not they’re successful at finding what they’re seeking .!4

!
Mouse movement is a measure of how far the participant’s mouse travelled in completing the tasks. 

Again, you could use this as a proxy for efficiency since it’s a measure of the kinetic effort needed to 
carry out the tasks. It would help you identify an application where users had to do lots of mousing 
around.!

Marker Analysis!

This analysis option contains four separate analyses that provide details on the markers you’ve added to 
each recording. For example, you could use this analysis to count up all of the “X: Usability problem” 
markers. But even if you’ve spent the time to carefully mark up all of your recordings, I find it hard to see 
how these analyses will help you find usability problems. I don’t recommend you use this analysis.!

Search Results!

This analysis option allows you to count up the number of results in your search list. This is a powerful 
analysis feature as it allows you to count up anything that you can create a search for: for example, you 
could count up the number if clicks by web page for each task.!

Survey Analysis!

The analyses in this option will help you make sense of the questionnaire data. They’re fairly obvious to 
understand so I won’t spend time on them here.!
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Task Analysis!

The analyses in this option are the bread and butter of usability tests. If you choose only one analysis, 
this is the one to pick. Some of these analyses will work only if you remembered to code each parti-
cipant’s performance at the end of each task (see “Defining the success score” in Lesson 2).!!
Percent success shows the percentage of participants whose task score corresponds to a particular 

value. For example, you might want to know the answer to this question: “What percentage of parti-
cipants were successful across each task?” If you used the task scores shown in Table 2, this means you’re 
asking, “What percentage of participants got a task score of 2 across each task?” If you click on the “Edit 
Metric” button you’ll be able to pick the score (‘2’ in this instance) that you’re interested in graphing. Be 
aware that this graph can become quite confusing. For example, you might configure it to show just the 
percentage of task failures (‘0s’ if you’re using the scores in Table 2), yet the graph title will still read “Av-
erage Number Succeeded by Task”. The title should read, “Average Number that scored 0”.!!
Task scores shows the success rate for the task: the standard measure of effectiveness. This is computed 

by averaging the task score across participants. For example, imagine you have 10 participants on a task. 
5 participants fail the task (task score = 0); 3 participants succeed but in a roundabout way (task score = 
1) and 2 participants succeed quickly (score = 2). The total score is 5 x 0 + 3 x 1 + 2 x 2 = 7. The task 
score for this task will therefore be 0.7 (it is calculated as an average, so we need to divide by 10, the 
number of participants). !!
Task success distribution shows the data as a stacked bar chart, a standard way of plotting the distribu-

tion of completion rates .!5!
Time on task shows how long each participant took on each task: the standard measure of efficiency.!

Web Page Analysis!

This analysis option comprises two separate analyses that provide information on web pages. If you’ve 
been testing a web site (or a browser-based application), you’ll be interested in these analyses.!!
Time spent on web page(s) allows you to examine how long participants spent on one or more specif-

ic web pages. By choosing the “Edit metric…” button, you can restrict the analysis to specific pages (for 
example, the set of pages that comprise the checkout screens). The problem with the way this function is 
implemented is that you need to select web pages from a dialog box that can’t be resized or sorted (for 
example, by web page title or by URL) and this makes it unnecessarily slow and difficult. Maybe TechS-
mith will improve this in the next release.!!
Web page changes lets you see how many different web pages each participant viewed when complet-

ing the tasks. You could use this as a proxy measure for efficiency: the closer this number is to the “ideal” 
number (that is, the number of pages that an expert would view in completing the task) the better the 
web site.!
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Which measure is right for me?!
Morae allows you to carry out lots of different analyses — so many, in fact, that it’s easy to get confused. 
In case you need reminding, the usability standard ISO 9241-11  defines usability as:!6

!
“Extent to which a product can be used by specified users to achieve specified goals with effect-

iveness, efficiency and satisfaction in a specified context of use.” !!
This definition helps us operationalise usability by focusing on measures of:!

! Effectiveness.!

! Efficiency.!

! Satisfaction.!!
In Tables 5-7, I’ve tried to make it easier for you to pick an analysis by relating Morae’s measures to the 
ISO definition of usability. In each case, after doing the analysis, I recommend that you right-click on the 
graph and chose “Export As > Data…” and then manipulate and graph the data in a program like Excel.!!
Table 5: Measures of Effectiveness"

!
Table 6: Measures of Efficiency"

!
Table 7: Measures of Satisfaction"

!

If you want to measure… Then pick this analysis…

Success rate Task Analysis > Task Success Distribution

Number of errors Marker Analysis > Count of Markers (Choose “Edit 
Metric” and show only markers of Type X, where X is 
the marker you used to show an error).

If you want to measure… Then pick this analysis…

Time on task Task Analysis > Time on Task

Time spent in one specific part of the applica-
tion

Application Analysis > Time spent in specific 
window(s) or dialog(s)

Time spent on specific web pages Web Page analysis > Time spent on web page(s)

Number of web pages visited Web Page analysis > Web page changes

Number of clicks Input Device Analysis > Mouse Clicks

Kinetic effort Input Device Analysis > Mouse Movement

If you want to measure… Then pick this analysis…

Satisfaction Survey Analysis > Average Scores

!46

 ISO 9241-11:1998 Ergonomic requirements for office work with visual display terminals (VDTs) -- Part 11: Guidance on usability.6



Morae For Usability Practitioners

Quick activity: Data analysis 
In this activity, you’ll check that you logged the tasks correctly.!!
Log your tasks 
Following the instructions above, review the session you moderated, checking in particular that you cor-
rectly logged the beginning and end of each task: check that the start and end points are at the correct 
location and that the task number is correct. Then score each task to define the level of task completion.!!
Analyse the data 
1. Plot the time taken to complete each of the tasks. Edit the graph so that the time taken for each 

task is written at the top of each bar. !
2. Plot the completion rate (success score) taken to complete each of the tasks. Edit the graph to add 

a “constant line” at a value of y=1 (that is, success score=1).!!
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Lesson 8: Presenting the data!

This lesson covers the steps you’ll need to take to present the 

results from your usability test in a report or video.!
!
“Technology is the name we give to stuff that doesn’t work properly yet.” — Douglas Adams (1952 – 2001).!!
There are many ways to present the data from a usability test. Some people create a detailed white pa-
per, packed with graphs and analyses. Other people prefer to create a slide deck in an application like 
PowerPoint with screenshots and call outs. Others create a highlights video, demonstrating where parti-
cipants experienced problems. And some development teams just want a prioritised list of usability prob-
lems that need fixing.!!
Because of this variety, don’t expect Morae to provide a one-stop shop for your situation. With one ex-
ception — the highlights video — you will almost certainly need to use other software to complete 
your presentation of the data. For all other types of report, you’ll need to get the data out of Morae and 
into another program, like Excel. Here’s the approach I recommend:!!
! Export the list of usability problems to Excel.!

! Create screen shots.!

! Develop a highlights video.!

! Archive the Morae file.!!
Let’s look at each of these in turn.!

Exporting the list of usability problems to Excel!
The most basic form of usability test report is a bug list: a prioritised list of the usability issues. The fol-
lowing process assumes that you have already completed the steps in Lesson 6, “How to find and review 
the usability problems”. In other words, you’ve already identified the usability issues in Morae by adding a 
marker to the recording and you’ve described the usability problem in the “Notes” field of the marker 
dialog. It’s not important to have assigned a priority to the issue, as in this workflow you’ll do this in the 
exported file.!!
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To export the usability issues: !
1. Click on the “Analyze” tab and ensure that the search function is set to search “Entire recording” and 

“All Recordings” (see Figure 23). (If you can’t see a ‘search results’ area, you may need to drag the 
panel border at the bottom of the screen upwards or choose ‘View > Restore Views’).!

Figure 23: Configuring the search to search all recordings"

" !!
2. Select “Search > Modify Search…” or click the “Modify Search” button or type “Ctrl-R”.!
3. In the pop-up dialog box, ensure that “Markers” is the only checked box.  !
4. Right-click on the search results and choose “Export Results…”!
5. Save the file to your desktop using a memorable name, like “Observations”.!!
Note: If you’re testing a web site, then in Step 3, choose “Event by Web Page (Markers)” instead of 
“Markers” as then the exported file will also contain the application page alongside the observation. This 
will allow you to group the observations by web page when you open the file in Excel.!!
To import the usability issues into Excel: !
1. Confirm that you have a .csv file on the desktop (this is the file you exported from Morae Manager 

— “csv” stands for “comma separated values”).!
2. Launch Excel and open the file, selecting “commas” as the delimiter. (Don't double-click the file. Excel 

is a bit clueless and will only launch its “Text Import Wizard” if you open the file from within Excel. If 
you don't go through the Wizard, Excel treats the commas as part of the file rather than as a delim-
iter).!

3. Clean up the worksheet by removing the columns from the spreadsheet you don’t need (such as the 
“Event” column, which will probably just say “Marker”). Then change the titles of the columns to make 
them more explanatory: I change, “Recording” to “Participant”, “Elapsed time” to “Time”, “Owner” to 
“Observer”, and “Notes” to “Observation”.!

4. Add an additional column at the far left of the worksheet. Title the column, “Ref.” and use it to num-
ber each usability issue (so that it can be uniquely referenced). !

5. Add two columns at the far right titled, “Priority” and “Recommendation”. !
6. Work through the usability issues, defining a priority and adding a recommendation for each one. Re-

move any duplicate issues as necessary.!

Creating screen shots!
Every good usability report will contain a screen shot to help people understand the usability issue, 
either in a written report or in a slide deck. Creating screen shots for each problem is straightforward in 
Morae. !!
There are two main steps in the process. First, you need to get to the right part of the recording. 
Second, you need to create the screen shot.!!
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To find the right part of the recording and take a screen shot: !
1. Follow steps 1-6 above (in the section titled “to export the usability issues”).!
2. Click on the first search result. The playhead jumps to the first usability issue.!
3. From the “File” menu, choose, “Save > Main Video Frame…” For best quality, ensure that the “Save as 

type” field reads “bmp files (*.bmp)”. (Although this creates a large file, the other alternative is a 
medium-quality jpeg that won’t look as good in your final report. In my workflow, I import the .bmp 
screenshots into Photoshop, crop the images and then save them as high quality jpegs for importing 
into PowerPoint or Word.)!!

Quick activity: Exporting data 
Use Morae’s search function to show all of the markers for your participant’s recording. Then export the 
markers and import the file into Excel. Repeat the process for a second participant’s data.!

Developing a highlights video!
Creating a highlights video is the one task that you can do entirely from within Morae and is one of 
Morae’s key strengths. If you’re used to creating highlights videos using analog tape or by importing digit-
al video, you’ll find Morae saves you hours, if not days.!!
How to create participant videos instantly 
If you just want a video recording of the entire participant session (perhaps as a backup or to hand to 
the development team) you don’t even need to use Morae Manager. You can simply save a recording of 
the session to your hard disk as you watch and listen to it with Morae Recorder. To create a video in this 
way, you need to check the box “Save session as .WMV” in the “Connect to Recorder” dialog (see Figure 
10). !!
The quality of the video isn’t as good as you can achieve by creating videos in Morae Manager but it’s 
certainly good enough to distribute to people.!!
It would be nice if you could create these videos in Morae Recorder, but you can’t. You have to be run-
ning Morae Observer and be connected to a machine running Morae Recorder to record a live .WMV 
video.!!
To create a highlights video most efficiently, you really need to have spent time adding markers to each 
video. This helps enormously, since you may have added a note to your observation that reads something 
live, “Great video clip!”.!!
An alternative approach is to convert the relevant “O” markers to another kind of marker (like “V” for 
“Video clip”) or even to include this marker when you make the observations. Then you can filter the 
timeline to just show the “V” markers. As I mentioned in Lesson 2 (“Editing Recorder’s default markers”), 
I don’t recommend that you use a variety of marker types since it causes a great deal of confusion. In my 
experience, the extra benefits that you get from having different markers is outweighed by the time it 
takes to create them and the errors it causes when data logging (the test observer needs to classify each 
observation before making it, which can be quite a lot of cognitive overhead). But if you have used addi-
tional markers and just want to show the “V” markers, here’s how.!!
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To show only the “V” markers: !
1. Click on the “Filter Off” button and select “Filter by separate criteria” (see Figure 24).!

Figure 24: The marker filter pop-up window."

" !
2. Select the “Specific markers” radio button, then check the “Marker type” check box and then select 

the “V - Video highlight — an “Ah-ha!” moment” marker (see Figure 25).!

Figure 25: Selecting just the “Video highlight” markers."

" !
3. Click “OK”.!
4. All of the markers will be greyed out, except for the “V” markers. You can now click on each marker 

in turn to jump to that part of the recording (see Figure 26).!

Figure 26: The timeline showing all markers greyed out, except for the “V” markers."

" !
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!
To create a video clip: !
1. Drag the playhead to the point in the video that you have marked as video worthy.!
2. Play the recording to find the best location for the beginning of the video clip. You can fine-tune the 

position of the playhead using an extensive array of keyboard shortcuts (see the section, “Navigating 
the recording” in Appendix 1). For example, to step through the recording frame-by-frame use Ctrl-
Left Arrow (to go back) and Ctrl-Right Arrow (to go forward). To zoom in on the time line and get 
more space to move the playhead, use the “+” key.!

3. Mark the beginning of the clip by clicking the “Set selection start” button (the green triangle) or by 
pressing Ctrl-J.!

4. Find the end of the clip, and mark it by clicking the “Set selection end” button (the red triangle) or by 
pressing Ctrl-K.!

5. Create a video clip of the selection by clicking the “Create video clip” button or by pressing Ctrl-
Shift-V. !

6. In the “Video Clip Properties” dialog, you can name the clip, change the position of the picture-in-pic-
ture or adjust its opacity and make other customisations. Or you could just stick with the defaults.!

7. The video clip now appears under the “Video Clips” folder for that participant.!!
The final step in creating the highlights video is to assemble all of the clips so that you can tell an inter-
esting story. You achieve this using Manager’s “Present” tab. If you switch to this tab, you’ll see a “Clip 
Bin” that contains all of the video clips you’ve created. You simply drag and drop video clips from the clip 
bin onto the Storyboard at the bottom of the screen. It’s easy to create multiple storyboards: just click 
on the tab (see Figure 27).!

Figure 27: Adding a new storyboard"

" !!
Creating persuasive highlights videos for a presentation 

A highlights video is as much a persuasion tool as a research report, so you need to ensure your high-
lights video is both concise and comprehensive. This is a hard balance to achieve: some design teams may 
need to see several participants struggling with the same issue before they are convinced of a problem. 
Other design teams may be convinced after just one compelling video clip. How can you meet the needs 
of both audiences?!!
To achieve the most persuasive results, here’s a recommended workflow that ensures you can deal with 
both these eventualities.!!
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1. By this point, you'll know the main usability issues. Create at least two video clips from different par-
ticipants to illustrate each issue. !

2. Create a storyboard for each issue and drop each video clip onto it. Re-order as you go so that the 
most persuasive examples are at the start.!

3. Produce separate videos for each Storyboard (select “Produce Highlight Video…” from the File menu, 
or type Ctrl-H). Give each video a meaningful name so you know which usability issue it illustrates.!

4. When showing the videos, start with the most important issue. If the audience buys in and agrees, 
stop the video and skip to the next issue/video… or keep it rolling if there are doubters. This ap-
proach works well because the biggest problem in presenting results is simply getting through them 
all!!

Creating highlights videos for a report 

If you won’t be present when people view the videos — for example, if you’re distributing them on a 
DVD or over a network — you’ll probably want to top and tail your video by adding some text to it, or 
perhaps you’ll want to add some text to introduce certain video clips. You do this by creating what 
Morae calls, “Title Clips”.!!
To create a title clip: !
1. Switch to the “Present” tab.!
2. Choose “Create > Title Clip…” or type Ctrl-Shift-T.!
3. This opens the “Title Clip Details” dialog that allows you to add your text. (Expert tip: to customize 

your title clips, create a slide in PowerPoint with your logo, export it as an image and then import it 
via the “Use background image” checkbox in this dialog).!

4. Click on “OK”. Your title clip appears under the “Title Clips” section.!
5. Drag items to the storyboard until you’re happy with the order.!!
The final step is to create the highlights video, which you do by selecting “Produce Highlight Video…” 
from the File menu, or typing Ctrl-H. This launches Morae’s “Production Wizard” which will ask you 
some questions about the video encoding options and the video size. If you’re interested in the strengths 
and weaknesses of each option, look through the Morae Manager help system (really, it’s very good). 
However, here’s a practical guide.!!
To produce a video:  

! If you want to share the video files over the Internet, choose “Upload to Screencast.com”. (Don’t 
worry, you can put the videos in a password protected area). You’ll need a Screencast.com account to 
use this feature, but it’s free to create an account that has 2Gb of storage space and a 2Gb monthly 
bandwidth.!

! If you want to share your video by email, choose “Produce to file”, then “WMV”, then “Standard video 
size” and choose 640x480. This should produce a relatively small file that is suitable for email.!

! If you want to put your video on a corporate network or your own web site, choose “Produce to 
file”, then “MPEG-4”, then “Largest video size (recommended)”. As well as the video itself, this will 
create a number of files (such as an html “wrapper”) that you can copy to a web server.!

! If you’re going to present the videos in PowerPoint, select “Produce to PowerPoint”, then “AVI”, then 
“Largest video size (recommended)”.!!
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Gotcha: Although Manager’s .AVI files will work fine on your computer, don’t think they’ll work fine on 

anyone’s computer. To view Morae’s AVI files, you need to install TechSmith’s TSCC codec. This codec is 
installed as part of the Morae installation but it’s not present by default on Mac or Windows computers. 
If you want to distribute the AVI files to Windows users, make sure you use Morae Manager’s “Pack and 
show” option (while in the “Present” tab, choose “File > Pack and Show”). This creates a self-extracting 
zipped .EXE file that includes the codec. To view AVI files, Mac users will have to manually install the En-
Sharpen decoder from TechSmith’s web site. This is a free download from http://www.techsmith.com/
codecs/ensharpen/default.asp. But if you want to share your video with Mac users, a better solution is to 
produce an MPEG-4 video and share that, since it will play natively on Mac computers.!!
From good to great 
Morae Manager provides all the tools you need to make good usability highlights videos. But there are a 
couple of features that TechSmith chose not to include in Morae that turn a good highlights video into a 
great one: pan & zoom and callouts. These features let you emphasise parts of the recording in a very 
compelling way.!!
Pan & zoom. Often you want the video to focus on just one area of the screen, for example the text 

that a participant types in a search box. Pan & zoom lets you draw the viewer’s attention to only the 
most relevant part of your screen and helps you make your point more clearly. !!
Callouts. It’s sometimes useful to place a text note on the video to provide some context to the parti-

cipant’s behaviour. For example, you might want to add a note that reads, “She hasn’t seen the basket.” 
Callouts are like explanatory sub-titles that ensure your viewer really gets the message.!!
The reason I say that TechSmith “chose” not to include these features is because they already exist in 
another software package produced by TechSmith: Camtasia Studio. I suspect the reason TechSmith left 
these features out is to encourage people to buy Camtasia.!!
If you want to emphasise parts of the video with Morae, your only option is to insert a title clip prior to 
the key moment in the video. Adding a text note to the title clip will help underscore the point you want 
to make — but that’s as much as you can achieve.  

Archiving the Morae file!
Once your project has finished, you’ll want to recover all of the disk space taken up by the files that you 
no longer need so you can move onto your next test. Which files can you delete and which files do you 
need to archive?!!
Files you can delete: 

! The original participant files (with the extension .RDG ). Once you have imported these into Manager 7

you can drop the original files in the Recycle Bin. You’re not deleting the data because when you im-
port the files into Manager it makes a copy of these files inside the project folder.!!
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Files you should archive before deleting: 

! The Manager project folder for your project. If your project is anything like mine, you’ll find that the 
project folder is less than 4 GB in size. This makes it an ideal candidate to burn to a DVD (the capa-
city of a regular DVD is 4.7 GB). So if you have a DVD writer in your computer, burn the whole of the 
project folder to a DVD and then delete it from your hard disk. Alternatively, you could move the files 
to an external hard disk.!

! Any highlights videos you have created. !

! I also include in the archive any additional files I’ve created in Excel (such as when I’ve exported data), 
just to make sure they’re associated with the project. But because these files will be small, there’s no 
need to remove them from your computer.!!

Gotcha! Manager includes a feature called “Export Project Components” on the “File” menu. If you use 

this dialog, you’ll see that you can use it to create a “project archive”. The good news is that this option 
creates an archive of your participant recordings (with all of the markers, tasks and survey responses), 
including the title clips you created. It also gives you the option of password-protecting your file (unlike 
Manager itself, which doesn’t give you the chance to password protect a project). The bad news is that it 
doesn’t include any storyboards or graphs you’ve created. More seriously, you need to import the 
archive into an existing Manager project that has at least one recording in it already. This feature is inten-
ded as a fairly rudimentary way to help different people share marked-up project recordings with each 
other but it’s not a good way to archive your project. Instead burn the project folder to a DVD and put 
the DVD somewhere secure.!
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Lesson 9: Becoming an expert!

This lesson shows you how to extend your knowledge of Morae.!
!
“I cannot imagine any condition which would cause this ship to founder. Modern shipbuilding has gone beyond 

that.” — Edward John Smith (Captain of Titanic) (1850 - 1912)!!
Like any practical skill, the way to improve your knowledge of Morae is to use it. So the best way to be-
come an expert user is to start using Morae to plan, run and analyse your usability tests. As you use the 
program more, you’ll find other questions occur to you. If this guide doesn’t answer your questions, then 
here are some resources you can turn to.!

How do I…?!
If you want an in-depth discussion of particular features or functions, here is a list of additional resources 
for Morae that complement this guide and that will help you extend your knowledge of the program:!!
! Morae Learning Center  

http://www.techsmith.com/tutorial-morae.html  
TechSmith’s web site contains various lessons on using Morae, many with example videos. The site 
includes sections on getting started, setup and recording, observing and logging, analysing results and 
sharing your findings.!

! Morae Support Centre  
https://support.techsmith.com/hc/en-us/categories/200174588-Morae-Technical-Issues 
This is the place to turn if you have a technical problem with Morae and need to find a solution.!

! Morae Documentation  
http://www.techsmith.com/tutorial-morae-documentation.html  
If you need a fresh copy of the “Getting Started Guide” or a PDF with the complete Help system, this 
is the page to visit.!

! TechSmith Newsletter Archive  
http://www.techsmith.com/newsletter-archive.html  
TechSmith send out a newsletter once a month with articles, case studies and tips and tricks to help 
you get the most out of Morae. You can sign up for the newsletter or just go here to read the back 
issues.!

Short articles on Morae!
! Heuristic Evaluation with Morae  

http://www.userfocus.co.uk/articles/morae-he.html  
Did you know you can use Morae to speed up the time it takes to do a heuristic evaluation? This 
‘How do I…’ article gives you step-by-step instructions on how to carry out an expert review with 
Morae, complete with explanatory screen shots.!
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! Usability Testing with Morae  
http://www.joelonsoftware.com/articles/UsabilityTestingwithMorae.html  
This article by Joel Spolsky shows how you can use Morae for a two-participant usability test (the 
usability test was of remote assistance software).!

! Usability Tests and Eye Tracking With Morae  
http://www.scoreberlin.de/usability-artikel/usability-tests-eyetracking-en/ 
This article describes a way of combining your eye tracking data into your Morae recordings. !

Help improve this guide!
Another way to extend your knowledge is to write down your experience and share it with other 
people. Do you have an unanswered question about how to use Morae in a usability test? Have you 
found any of the instructions or guidance in this document hard to follow? Have you discovered a 
“gotcha” that I didn’t warn you about? If so, write it down and send it to me and I’ll include it in the next 
version of this document. You can contact me at david.travis@userfocus.co.uk. I look forward to hearing 
from you!!
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Lesson 10: Test Yourself!!

This lesson lets you test out some of the things you’ve learned.!

Questions!

Morae Recorder!

1. What is a Study Configuration file?!
2. What is AutoPilot?!
3. What’s the difference between a ‘marker score’ and a ‘marker’?!
4. Why might you use the ‘Batch Process’ option?!

Morae Observer!

1. What is the ‘Scale to Fit’ view?!
2. The video you’re observing is lagging about 5s behind the test. What would you do?!
3. You’re running a test alone and can’t use a mouse/keyboard to log the session. How can you still add 

markers during the test?!
4. Each person using Observer can log markers but only one person can log tasks. Why is this?!

Morae Manager!

1. How do you move a marker?!
2. You need a screenshot for your report showing a web form that a participant filled out incorrectly. 

You don’t want to include the PiP. How would you do it?!
3. Only one of your 12 participants viewed the privacy policy. How could you quickly find the right part 

of the right recording?!
4. Why might you need to merge a study?!

Pot luck!

1. What’s the difference between Recorder, Observer and Manager?!
2. How do you create a new marker in Manager?!
3. What’s the best video format for sharing a highlights video on a web site?!
4. You want to connect to the test computer over a network, but don’t know its IP address. How would 

you find out the IP address of the test computer?!
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Search!

To carry out this exercise, you need to open the example project that comes with Morae.  Choose ‘File 
> Open > Example Project’. Once the project loads, select the ‘Morae Example Project Usability 
Test’  (the third project in the ‘Analyze Project’ pane). Then answer all these questions using the ‘Search’ 
function.!!
1. One of the participants viewed a forum post by John Kirk that read, ‘Nice, thanks for sharing’. What 

did the participant do immediately after reading this post? !
2. How many participants used the search function on the TechSmith site (the URL of the search page 

contains the text ‘search.asp’)?!
3. How many observations were made (i.e. how many markers were created) on the TechSmith Com-

munity Subscription Center page (the URL contains the text ‘subscription.asp’)?!
4. How many participants moved the browser window?!
5. How many usability errors (‘X’ markers) were spotted in total in the usability test?!
6. How many times did Participant 3 double-click during Task 2? !
7. Which participant used the <TAB> key the most?!
8. On Task 2, which participant viewed the fewest pages when completing the task?!!
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Answers!

Morae Recorder!

1. A study configuration file (.mrcfg) defines information such as the task and marker definitions and the 
recording details, such as how to start and end recordings.!

2. AutoPilot is a tool for running unmoderated usability tests. Autopilot presents study and task instruc-
tions to the participant and logs the start and end of tasks automatically. !

3. You use markers to flag important points in a recording such as errors, quotes, and the start and end 
of tasks. You use marker scores to determine the severity of a marker (for example, the severity of an 
error). !

4. You would use this option because you have enabled the ‘Defer processing of recordings’ checkbox. 
This allows you to start another participant recording immediately and put recordings in a queue to 
be processed later. !

Morae Observer!

1. If the participant’s screen is larger than the computer you’re observing on, you won’t be able to see 
the whole screen at once. The ‘Scale to Fit’ view fits the entire recording into the viewing window!

2. In the ‘Connect to Recorder’ dialog, choose the ‘Mute audio to minimise time lag’ checkbox. !
3. You can log markers with a Wii Remote. !
4. Different observers may spot different issues, so it’s OK to have multiple markers. But a task can only 

start and finish at one time. If one person said the task started at 12.00 and another said it started at 
12.01, Morae wouldn’t know who to believe. !

Morae Manager!

1. Click and drag the marker. !
2. Choose ‘File > Save > Main Video Frame’ !
3. In the Analyze tab, choose ‘Modify Search’ then select the ‘Screen text’ checkbox, then choose ‘Modify’ 

and then type in some text that appears only on the privacy policy page (such as the URL). !
4. If the study configurations of your recordings don’t match each other, you see the ‘Mismatched Study 

Configurations’ dialog box. The ‘merge a study’ option allows you to match things like tasks and mark-
er definitions and combine your recordings into a single study so you can analyse them together. !

Pot luck!

1. Recorder creates a study configuration and saves the session. Observer allows you to view the ses-
sion from another computer. Manager helps you analyse the data and create highlights videos. !

2. Type Ctrl-M or click on the ‘New marker’ icon and fill out the dialog box that appears. !
3. Produce your highlight video in MPEG-4 format. !
4. On the test computer (the computer running Recorder), open the Command Prompt. At the com-

mand line, type ‘ipconfig’. !
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Search!

Note: If your results are different from these, you may be using a different version of the Example Project sup-

plied with Morae. The example project in Morae 3.2 had 4 participants in the Example Project Usability Test, 

whereas Morae 3.3 has 3 participants.!!
1. This was participant 2, who clicked the Back button. Solution: Choose ‘Modify Search > Screen Text > 

Modify’ then enter ‘thanks for sharing’. Then click the ‘Elapsed time’ hyperlink (0:03:07:32). Undock the 
viewer window and click play.!

2. 1 (Participant 2). Solution: Choose ‘Modify Search > Screen Text > Modify’ then enter ‘search.asp’ (the 
URL of the search results page).!

3. 2 (one for Participant 1 and one for Participant 3). Solution: Choose ‘Modify Search > Events by Web 
Page > Modify’. Select ‘Markers’ then select ‘Display events for only Web pages containing this text’, 
then enter ‘subscription.asp’.!

4. 1 (Participant 1). Solution: Choose ‘Modify Search > Window/Dialog Events > Modify’. Select ‘Specific 
window/dialog events’, type ‘Internet Explorer’, then ‘OK’. Scroll the list to find the ‘Move’ event. Re-
peat with ‘Firefox’ as the ‘Window/dialog title’ and you’ll see there were no ‘Move’ events with that 
browser.!

5. 9. Solution: Choose ‘Modify Search > Markers > Modify’. Select ‘Specific markers’, the ‘Marker Type’, 
then select the ‘X-Error’ marker. Click ‘OK’. View the list.!

6. Once. Solution: Choose ‘Modify Search > Mouse Clicks > Modify’. Then choose ‘Specific mouse clicks’, 
then ‘L Button Double-click’. Click OK. On the left hand side of the screen, choose ‘Selected Tasks’, 
then task 2; then choose ‘Selected recordings’, then ‘Participant 3’. !

7. P3 (14 times). Solution: Choose ‘Modify Search > Keystrokes > Modify’. Then choose ‘Specific key-
strokes’, then ‘Clear All’ (just in case’) then scroll right to find the Tab checkbox. Click OK. Click on 
‘Selected recordings’ and deselect all except Participant 1 (4 keystrokes), then do the same for Partic-
ipant 2 (1 keystroke) then finally for Participant 3 (14 keystrokes).!

8. P1 completed the task by viewing 3 pages. Solution: Choose ‘Modify Search > Web Page Changes > 
Modify’. Then choose ‘All web page changes’, then click OK. On the left hand side of the screen, 
choose ‘Selected Tasks’, then task 2. Then choose ‘Selected recordings’. Then check and uncheck each 
participant to see which has the fewest.!!
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Appendix 1: Morae Manager key-

board shortcuts!

File management!

Watching the recording!

Creating markers, selections, tasks and clips!

!
Navigating the recording!

Action Shortcut

Import recording Ctrl-I

Import video Ctrl-E

Action Shortcut

Player window shrink to fit Ctrl-Alt-S

Play / Pause Space

Play selection Ctrl-Alt-Space

Play task Ctrl-Shift-Space

Increase volume Ctrl-Up Arrow

Decrease volume Ctrl-Down Arrow

Action Shortcut

Set selection start Ctrl-J

Set selection end Ctrl-K

Create task from selection Ctrl-T

Create marker Ctrl-M

Create video clip Ctrl-Shift-V

Create title clip Ctrl-Shift-T

Create image clip Ctrl-Shift-I

Produce highlight video Ctrl-H

Add clip to storyboard Ctrl-Shift-C

Action Shortcut

Previous frame Ctrl-Left Arrow

Next frame Ctrl-Right Arrow

Step Back Ctrl-Shift-Left Arrow

Step Forward Ctrl-Shift-Right Arrow
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Skip forward 1 second Ctrl-1

Skip forward 2 seconds Ctrl-2

Skip forward 5 seconds Ctrl-3

Skip forward 10 seconds Ctrl-4

Skip backward 1 second Ctrl-Shift-1

Skip backward 2 seconds Ctrl-Shift-2

Skip backward 5 seconds Ctrl-Shift-3

Skip backward 10 seconds Ctrl-Shift-4

Zoom in +

Zoom out -

Zoom to entire recording Ctrl-Minus

Zoom to playhead position Ctrl-Shift-Plus

Zoom to selection Ctrl-Alt-Plus

Zoom to task Ctrl-Plus
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User Experience:  
The Ultimate Guide to Usability

Gain hands-on practice in all the key areas 

of UX — from interviewing your users through 

to prototyping and usability testing your 

designs. 

Build a UX portfolio to boost your job 

prospects as you complete five real-world 

sample projects. 

Gain industry-recognised certification by 

preparing for the BCS Foundation Certificate in 

User Experience.

www.uxtraining.net

Master user experience in this practical, video-based, online training course.

The depth and breadth of content covered in 

this course is seriously impressive. All of the 

major UX techniques are covered in a way that 

anyone could take this advice and apply it to 

their own projects or organisation. If you want 

to learn how to do user-centred design, this is 

the course to get.  

— Independent review by Matthew Magain, 

co-founder, UX Mastery

“

I already had some in-house, quasi-UX 

mentoring, but taking this course is what truly 

opened my eyes to seeing everything in the 

world from a design and user goals 

perspective. I promote this course anytime I 

see or hear anybody asking where they should 

get started in UX Design/Research.  

— Course review by student Geoff Wilson

“

Dr. Travis has created a very thorough, very 

engaging overview of the UX Lifecycle, with 

lots of great real world examples and war 

stories from his own considerable experience 

to illustrate the guidelines and techniques he 

teaches you. Well worth the time and money.  

— Independent review by veteran usability 

consultant Dr. Deborah J. Mayhew

“

http://www.uxtraining.net
http://www.uxtraining.net

